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Introduction

Introduction
PowerPoint 2003 is a powerful graphics application that allows you to create presentations for printing or on-line viewing 
using a variety of different tools. These range from wizards to help you with the content and look and feel of your 
presentation to animation tools to create moving images.

All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.

How to use this guide

This manual should be used as a point of reference following attendance of the PowerPoint 2003 training course. It covers 
all the topics taught and aims to act as a support aid for any tasks carried out by the user after the course.

The manual is divided into sections, each section covering an aspect of the course. The table of contents lists the page 
numbers of each section and the table of figures indicates the pages containing tables and diagrams. 

Objectives

Sections begin with a list of objectives each with its own check box so that you can mark off those topics that you are 
familiar with following the training.

Instructions

Those who have already used a similar application before may not need to read explanations on what each command 
does, but would rather skip straight to the instructions to find out how to do it. Look out for the hand icon  which 
precedes a list of instructions. 

Appendices

The Appendices list the toolbars mentioned within the manual with a breakdown of their functions and tables of shortcut 
keys.

Keyboard

Keys are referred to throughout the manual in the following way:

[ENTER] – denotes the return or enter key, [DELETE] – denotes the Delete key and so on.

Where a command requires two keys to be pressed, the manual displays this as follows:

[CTRL][P] – this means press the letter “p” while holding down the Control key.

http://bookboon.com/
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Commands

When a command is referred to in the manual, the following distinctions have been made:

When menu commands are referred to, the manual will refer you to the menu bar – E.g. “Choose File from the menu 
bar and then Print”.

When dialog box options are referred to, the following style has been used for the text – “In the Page Range section 
of the Print dialog, click the Current Page option”

Dialog box buttons are shaded and boxed – “Click OK to close the Print dialog and launch the print.”

Notes

Within each section, any items that need further explanation or extra attention devoted to them are denoted by shading. 
For example:

“PowerPoint will not let you close a presentation that you haven’t already saved without prompting you to save.”
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The Basics

1 The Basics
Objectives

By the end of this section you will be able to identify

•	 Title Bar
•	 Menu Bar
•	 Toolbars
•	 Tri Pane View (Normal)
•	 Ask a Question

Mein Wissen rund um Big 
Data und SAP möchte ich 
sinnvoll  einsetzen. Bin ich bei 
euch  richtig, E.ON?

Lieber Herr Bennett, mit Ihren 
Fachkenntnissen können Sie bei 
uns viel bewegen.  
Bringen Sie Ihr Know-how in zukunftsweisende Projekte 
und Applikationen ein: Ob bei der energetischen Vernet zung 
von Smart Homes, der Steuerung virtueller Kraftwerke oder 
der Realisierung anspruchsvoller Logistik-Konzepte – der 
Energiesektor bietet vielfältige Herausforderungen für IT-
Consultants, -Architekten und -Projektmanager. Entfalten 
Sie Ihre Kompetenz und geben Sie Ihrer Karriere neue 
Impulse.

Ihre Energie gestaltet Zukunft.

www.eon-karriere.com
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The Basics

1.1 What is PowerPoint?

PowerPoint is a presentation graphics package that lets you create formatted presentations which can be used in a number 
of ways. You can produce projects such as overheads for a team briefing, slides for a business meeting or interactive on-
screen presentations on your company’s products. It allows you to produce:

•	 Animated Presentations shown on a monitor or overhead screen
•	 Overhead Projector Transparencies
•	 Paper Printouts of your slides
•	 Notes for the Speaker
•	 Handouts for the Audience
•	 35 mm slides

1.2 Launching PowerPoint

  To launch PowerPoint:

Mouse

•	 Click the Start button on the Taskbar, and select Programs. Click Microsoft PowerPoint 2003 
 from the sub-menu list. 

PowerPoint 2003 displays the Tri-pane displayed below when it is first launched. This view is also known as Normal view.

http://bookboon.com/
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1.3 The PowerPoint Screen

Title Bar  The coloured bar that appears at the top of the PowerPoint window. The title bar tells you which 
application you are using and if the presentation you are in is maximized, it will also contain the name 
of the presentation.

Menu Bar PowerPoint 2003 has two menus, the menu bar and shortcut menu. The menu bar displays all options 
available within PowerPoint and is accessed using the left mouse button. The shortcut menu however, 
only displays some of the more frequently used options and is accessed via the right mouse button.

Toolbars Toolbars are a form of shortcut menu. They allow the user to carry out some of the most common 
functions quickly. 

In PowerPoint 2003 there are numerous toolbars available. By default, the Standard, Formatting, Drawing and Task Pane 
toolbars are displayed when PowerPoint 2003 is launched.

If the mouse pointer is left stationary over an icon on a toolbar, a ‘tool tip’ appears stating the use of the tool.

http://bookboon.com/
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  To Activate a Tool Button on the Toolbar

Mouse

•	 Click the left mouse button on the required tool.

  To Display Other Toolbars

Mouse

•	 Click the right mouse button on any toolbar currently displayed, e.g. on the Formatting toolbar. This action 
will cause a list of all available toolbars to be displayed.

01001001 01010100 00100000 01010100 
01110010 01100001 01101001 01101110
01001001 01010100 00100000 01010100 
01110010 01100001 01101001 01101110
01001001 01010100 00100000 01010100 
01110010 01100001 01101001 01101110
01001001 01010100 00100000 01010100 
01110010 01100001 01101001 01101110

          Ziel: 

Du entwickelst 

unsere Zukunft.

Wir Deine.

IT-Traineeprogramm

In 18 Monaten durchläufst Du 
3 verschiedene Stationen, wirst 
von einer Führungskraft als 
Mentor betreut und profitierst 
von einem breiten Seminar-
angebot. Anschließend kannst 
Du eine Fach-  oder Führungs-
laufbahn einschlagen.
www.perspektiven.allianz.de

Allianz Karriere
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The Basics

•	 Select the toolbar required by clicking on the specific toolbar, e.g. WordArt.

The same method is used to hide a toolbar.
You can customise existing toolbars by selecting the Customise option from the Tools menu. You can then add 
extra buttons or remove those you don’t require.

Task Pane

A task pane is a window that collects commonly used actions in one place. The task pane enables you to quickly create 
or modify a file, perform a search, or view the clipboard.

It is a Web-style area that you can either dock along the right or left edge of the window or float anywhere on the screen. 
It displays information, commands and controls for choosing options. Like links on a Web page, the commands on a task 
pane are highlighted in blue text, they are underlined when you move the mouse pointer over them, and you activate 
them with a single click.

A task pane is displayed automatically when you perform certain tasks, for example when you choose the File, New 
command from the menu bar to create a new presentation.

http://bookboon.com/
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  To display a task pane at any time:

Mouse

•	 Choose Task Pane from the View menu.

Or

•	 Choose View, Toolbars, Task Pane from the menu bar.

Or

•	 Right-click the menu bar or any toolbar and choose Task pane from the shortcut menu.

You then need to navigate to the particular task pane you want to work with. You can display any of the main task panes 
that are available by clicking the down arrow near the upper right corner of the pane that is displayed initially, and choosing 
the name of the pane you want to open from the drop-down menu.

You can navigate among the task panes you have recently displayed by clicking the Back and Forward Web-style buttons. 
The Home button will display the ‘Getting Started’ Task Pane. Close the task pane by using the clos e button.

1.4 Using Help

PowerPoint 2003 offers several ways of obtaining help. 

http://bookboon.com/
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  Ask a Question for Help

•	 Typing a question or phrase in to the Type a question for help box that you will find in the upper-right 
corner of the application, and then pressing [ENTER]. 

•	 Matching topics will be displayed in the Task Pane. Single click on the topic that you wish to view

 
If you want to repeat a question you have already typed during the current session, you can simply select the question 
from the drop-down list on the Ask a Question Box.

If no possibilities are listed , try searching using a different word or phrase. For example, you will not find any topics listed 
under “parallel” but will find some information listed under “align”. 

  Using the Table of Contents

•	 Select Microsoft Office PowerPoint Help on the Help menu. 
•	 The Help Task Pane will be displayed. 

http://bookboon.com/
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•	 Click on the Table of Contents hyperlink.

Lieben Sie Herausforderungen?

Möchten Sie innovative Lösungen für
führende Unternehmen entwickeln?

Wollen Sie dem weltweit größten
Beratungsunternehmen angehören?

Entdecken Sie Ihre vielfältigen
Karrieremöglichkeiten. IBM ist auf der
Suche nach den besten und hellsten
Köpfen. Nach Menschen, die Möglichkeiten
entdecken, wo andere nur Probleme sehen.
Nach Mitarbeitern, die auch Mitgestalter
sein wollen. Wir suchen diese Menschen
aus dem Anspruch heraus, die Welt täglich
ein bisschen besser zu machen. Sie sind
ideengetrieben, zukunftsorientiert und
möchten schon heute an den Lösungen
von morgen arbeiten? Dann sollten wir uns
kennenlernen!

Machen wir den Planeten ein bisschen smarter.
ibm.com/start/de

Alle Bezeichnungen, die in der männlichen Sprachform verwendet werden, schließen sowohl Frauen als auch Männer ein. IBM schafft ein offenes und tolerantes Arbeitsklima und ist stolz darauf, ein 
Arbeitgeber zu sein, der für Chancengleichheit steht. IBM, das IBM Logo und ibm.com sind Marken oder eingetr. Marken der International Business Machines Corp. in den Vereinigten Staaten und/oder 
anderen Ländern. Andere Namen von Firmen, Produkten und Dienstleistungen können Marken oder eingetr. Marken ihrer jeweiligen Inhaber sein. © 2010 IBM Corp. Alle Rechte vorbehalten.
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•	 The Contents Tab breaks down the information into broad topics. Single click on the Book icon for the topic 
you want. This will open a list of subheadings.

•	 Single click to access the help topic you need. 

Using the Office Assistant

The Office Assistant can answer your questions, offer tips, and provide Help for a variety of features. 

  Opening the Office Assistant:

•	 Click on Show the Office Assistant under the Help menu 
•	 Type your question into the space provided.
•	 Click on Search. Topics that match your criteria will be displayed in the Task Pane

  Using ScreenTips:

Use ScreenTips to see information about different items on the screen. 

•	 To see ScreenTips for a dialog box option click on the Question Mark  button at the top right corner of 
the dialog box. 

If the dialog box does not have a Question Mark button look for a Help button or press [F1].

  Using Online Sources of Help

•	 If you are unable to find the information you require, PowerPoint makes it easy for you to connect to online 
sources that are likely to provide the resources you need. 

http://bookboon.com/
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You need an internet connection to make use of these online features.

JETZT BEWERBUNG 
AUFPOLIEREN.
Bereiten Sie sich optimal auf den Bewerbungsprozess vor 

und geben Sie Ihrem Profi l den letzten Schliff. Nutzen Sie 

unsere Tipps, Persönlichkeitstests und kostenlosen 

E-Books zu Studium, Business und Karriere. 

rwe.com/

Bewerberakademie

Anzeige_Bewerberakademie_178x126.indd   1 23.09.14   14:27
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Creating a Presentation

2 Creating a Presentation 
Objectives

The following topics are covered in this chapter:

•	 Creating a New Presentation
•	 Adding New Slides – entering and editing Text
•	 Slide Layouts – title slide, bulleted list, two column text
•	 Changing the Slide Layout
•	 Creating Blank Slides
•	 Adding Freeform Text
•	 Save a Presentation

http://bookboon.com/
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Creating a Presentation

2.1 Creating presentations

When you launch PowerPoint 2003, you are placed into a blank PowerPoint presentation, with one Title slide and the 
Getting Started Task Pane displayed.

  To start a new presentation

•	 Launch PowerPoint. The following screen will automatically be shown, opening you into a blank 
presentation, displaying a blank title slide.

There are many different layouts you can select for your slidse. You can select an appropriate layout including 
bulleted text, graphs, clipart etc. 

2.2 Adding New Slides 

When you start your new presentation, you are automatically placed into a Title slide layout. Whilst this is the default, 
you are free to choose any layout listed in the Slide Layout Task pane (see page 18). There are a number of methods to 
add further slides to your presentation.

  To add a new slide

Mouse

•	 Choose the New Slide icon  from the Formatting toolbar. PowerPoint will create a new bulleted 
list slide

Keyboard

•	 Press [CTRL] + [M]

http://bookboon.com/
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Creating a Presentation

PowerPoint will create a new slide and this new slide and all subsequent new slides will be based on the bulleted list layout.

Entering and Editing Text

Both the Title and Bulleted list layouts are specifically designed so that you can easily enter titles and bulleted list items.

  Entering text on a Title slide

•	 To add text to a slide click into the predefined text areas (placeholders) and type.

TMP PRODUCTION NY026057B
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gl/rv/rv/baf
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Creating a Presentation

  To create bullets on a Bulleted slide:

Mouse

•	 Click in the bullets area to anchor the cursor.
•	 Type your list item. To begin a new item, press [ENTER]. The bullet will automatically appear next to your 

cursor on the new line.

 

Multi-level Bullets

PowerPoint can create five levels of bullet points. Each has a different bullet point, a smaller text size and is progressively 
indented.

http://bookboon.com/
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  Demoting your bullets

Mouse

•	 Use the Increase Indent button  on the Formatting Toolbar.

Or

Keyboard

•	 Press [TAB]

  Promoting your bullets

Mouse

•	 Use the Decrease Indent button  on the Formatting Toolbar.

Or

Keyboard

•	 Press [SHIFT][TAB]

Editing text

http://bookboon.com/
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Once text has been entered on a slide it can easily be edited.

  To edit text on a slide:

Mouse

•	 Click on the text item to change – a shaded border will appear around the item and your cursor will flash 
somewhere within the text.

•	 Click with your mouse or use the arrow keys on the keyboard to move the cursor around within the text, 
and the [BACKSPACE] and [DELETE] keys to remove characters.

•	 When you have finished editing, click outside the text item to exit edit mode.

2.3 Changing the Slide Layout

“Layout” refers to the way things are arranged on a slide. A layout contains placeholders, which in turn hold text such as 
titles and bulleted lists and slide content such as tables, charts, pictures, shapes, and clip art. 

http://bookboon.com/
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All available layouts are displayed in the Slide Layout Task Pane. This Pane will automatically be displayed when you either 
create a new presentation or add a new slide to your existing presentation.

  To change a slide layout

Mouse

•	 Click on the Slide Layout you require in the Slide Layout Pane. 
•	 This will apply the selected slide layout to the current slide

  Reapplying a slide layout

•	 A layout can be reapplied to a slide by using the drop-down menu next to the desired layout option in the 
Task Pane 

Note: You can also insert a new slide from within the task pane. Point to the layout you want the slide to have, 
click on the downward arrow, and then choose Insert New Slide

  To insert a blank slide

Mouse

•	 Allow your mouse to hover over the Blank Auto Layout slide in the Task Pane; a drop down arrow will 
appear.

•	 Click on the drop down arrow

•	 Choose the Insert New Slide option

http://bookboon.com/
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2.4 Comments

Comments are like electronic sticky notes that can be attached to a slide. If you would like your presentation to be 
reviewed by colleagues you can ask them to insert comments about suggested changes instead of making changes to the 
presentation itself.

The comments appear in yellow comment boxes. Each Note inserted will show the reviewers name at the top. This name 
is taken from the information entered into the General tab of the Tools, Options dialog box. 

Comments won’t appear in outline view or in slide show view. 

  Inserting comments in a presentation:

Mouse

•	 In normal view, display the slide you want to add comments to.
•	 Select Insert, Comment.
•	 Type your comments into the yellow comments box and then click away.
•	 Move the comment box to your preferred position on the slide.

By right clicking on the comment you can get options to Edit and Delete the comment.

2.5 Adding Free Form Text

There will be times where you wish to insert text outside of one of the pre-defined text placeholders or perhaps on a 
blank slide. The Free Form Text box allows us the freedom to do this. Once you have added the Free Form text box, you 
can add it and resize it as you require.
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  Insert a text box

•	 On the Drawing toolbar, click Text Box  . 
•	 Click in your slide where you want to insert the text box. 
•	 Type in the text you wish to appear in the text box.
•	 Resize the text box if necessary using the white resizing circles on each side and corner and format your text 

as appropriate.

Note: You can use the options on the Drawing toolbar to enhance a text box for example, to change the fill colour 
just as you can with any other drawing object.

http://bookboon.com/
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2.6 Saving a Presentation

It is important to save your presentation regularly so that your work is not lost in the event of a system crash or a power 
failure.

Name and save a presentation file

The first time you save a presentation that you have created, you will need to allocate a file name.

  To save and name a presentation file:

Mouse

•	 Click on File, Save As.

•	 Use the Save in dropdown field to select the drive in which to save the presentation.
•	 Double click on a folder to open it. Repeat as necessary until the required folder is displayed in the Save in 

field.
•	 Type in a File name.
•	 Click on Save.

File Names can contain up to 255 characters and can include characters such as spaces and hyphens.

Subsequent Saves 

Once you have given a presentation a name and specified a location, you should then save that file regularly as you work. 

  To save a presentation:

Mouse

•	 Select File, Save
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Or

•	 Click on 

Or

•	 Press [CTRL] [S]

Saving a presentation with a new name

If you need to copy a presentation then you can save the current presentation under a different name thus creating a 
copy of the original.

  To save a presentation with a new name:

Mouse

•	 Click on File, Save As. The original presentation file name is automatically selected.
•	 Delete this and type in a new file name.
•	 Click on Save.

start up – mehr als ein 

trainee-programm. 

jetzt bewerben!

 Die Antwort auf fast alles. 
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3 Formatting a Presentation 
Objectives

The following are covered in this section:

•	 Selecting Placeholders and Text
•	 Formatting Text
•	 Formatting Backgrounds
•	 Formatting Numbered and Bulleted Lists
•	 Changing Case
•	 Slide Master
•	 Format Painter
•	 Smart Tags

Machen Sie die Zukun�  sichtbar

Kleine Chips, große Wirkung:  Heute schon sorgt in rund der Häl� e aller Pässe und Ausweise weltweit ein 
Infineon Sicherheitscontroller für den Schutz ihrer Daten. Gleichzeitig sind unsere Halbleiterlösungen der 
Schlüssel zur Sicherheit von übermorgen. So machen wir die Zukun�  sichtbar.

Was wir dafür brauchen?  Ihre Leidenscha� , Kompetenz und frische Ideen. Kommen Sie zu uns ins Team! 
Freuen Sie sich auf Raum für Kreativität und Praxiserfahrung mit neuester Technologie. Egal ob Praktikum, 
Studienjob oder Abschlussarbeit: Bei uns nehmen Sie Ihre Zukun�  in die Hand.

Für Studierende und
Absolventen (w/m):
 › Ingenieurwissenscha� en

 › Naturwissenscha� en

 › Informatik

 › Wirtscha� swissenscha� en

www.infineon.com/karriere
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3.1 Selecting Placeholders and Text

In order to change the appearance of text, it is firstly necessary to select or highlight either the text or the placeholder 
that the text sits in. There are a number of different methods used for selecting the text. 

Selecting Placeholders

Selecting the entire frame or placeholder is a very quick, efficient and consistent method of selecting text. Any formatting 
applied to a selected place holder will format all text sitting in the place holder

  To select the Placeholder:

Mouse

•	 Click into the text to be formatted.
•	 Click on the shaded border of the text box. This will change the pattern of the border line to indicate that all 

text in it is selected.

Or

Keyboard

•	 Click into the text to be formatted.
•	 Press [CTRL] [A].

Selecting Text

You may to apply different formatting to different parts of text within the one place holder or frame.
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  To select some of the text in a box:

Mouse

•	 Click into the text to be formatted.
•	 Click and drag through text to select it.

  To select text by paragraph:

Mouse

•	 Click into the text to be formatted.
•	 Triple click in the text to select a paragraph and any second, third, fourth and fifth level paragraphs below it.

Verwirklichen, worauf es ankommt –  
mit einer Karriere bei Siemens.

siemens.de/karriere
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3.2 Formatting Text

Text formatting allows you to change the font, size, colour and style of your text. Using similar formatting across your 
Word, Excel and PowerPoint documents helps to present a consistent and professional corporate image. Don’t forget, in 
order to format text, it is firstly necessary to select it.

The Format menu contains a variety of different options for formatting text on a slide.

  To format text using the Format menu:

Mouse

•	 Select the text you want to format. (see page 27).
•	 Select Format, Font.

•	 Set the options for Font, Size, Colour and Effects. Choose from Effects such as Shadow, Emboss and 
Underline.

•	 Click on OK.

You can also access these font formatting options using the shortcut buttons on the Formatting toolbar. (See 
Appendix). 

Colours offered are from your Colour Scheme, to use additional colours choose the More Colour option.
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Applying text formatting using the Formatting Toolbar

For the most commonly applied formats, you can make use of the Formatting toolbar.

  To apply formats using the Formatting Toolbar:

Mouse

•	 Select the text you want to format (see page 27).
•	 Click on the appropriate button to change font, size, style, colour and alignment of text.

Please refer to the Toolbars Appendix for a full list of all buttons on the Formatting toolbar.

3.3 Formatting Backgrounds

The background colour of all new slides is, by default, white. It is possible to apply a different colour, graded fill colour, 
pattern, texture or picture, which will override the default setting. The change applies to all slides that follow the design 
template of the currently selected slide

  To change the background formatting

•	 On the Format menu, click Background.

Under Background fill, click the arrow on the right of the box, and then do one of the following:

Select a colour from the colour palette that is displayed when the menu opens
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OR 

Select a colour outside the colour scheme by clicking More Colours…
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•	 You can also select a fill effect or picture as a slide background:
•	 On the Format menu, click Background.
•	 Under Background fill, click the arrow on the right of the box. Select Fill Effects.
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To use shading, click the Gradient tab, click a type under Colours, click a shading style, and then click OK. 
To use a texture, click the Texture tab, click the texture you want or click Other Texture to select a file and 
insert it, then click OK. 
To use a pattern, click the Pattern tab, select the pattern you want, select foreground and background colours, 
then click OK. 
To use a picture, click the Picture tab, click Select Picture to find the picture file you want, click Insert, and 
then click OK. 

•	 Do one of the following: 

If you want to apply the background to selected slides, click Apply. 

If you want to apply the background to all slides, click Apply to All.

A picture you use as a slide background will be stretched to fill the slide background area. If it is not of suitable 
proportions it will be distorted.

You can insert many popular graphics file formats into your presentation including Enhanced Metafile (.emf), 
Joint Photographic Experts Group (.jpg), Portable Network Graphics (.png), Windows Bitmap (.bmp, .rle, .dib) and 
Windows Metafile (.wmf) graphics. To insert other file formats you will need to install additional graphic filters.

3.4 Formatting Numbered and Bulleted Lists

Editing a Bulleted List

The bullets that PowerPoint assigns when you switch them on or use a bulleted list auto layout are controlled by the slide 
master template (see page 35). You can however choose different bullet symbols if you wish.

  To change bullet symbols:

Mouse

•	 Position cursor in paragraph.
•	 Select Format, Bullets and Numbering, Customise.
•	 To select a symbol from a different font change the Font prompt in the top left of the dialog box. 
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•	 Click on your chosen bullet point and click on OK.

You will find a good choice of symbols in the Webdings, Wingdings and Monotype Sorts fonts.
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Editing a Numbered List

The numbers that PowerPoint assigns when you switch them on or are controlled by the slide master template. You can 
however choose to edit the numbering if you wish.

  To change Number Styles:

Mouse

•	 Select the text or list whose numbering style you want to change. 
•	 On the Format menu, click Bullets and Numbering. 
•	 On the Numbered tab, do any of the following: 

To change the number style, click a style. 

To change the size, click the arrows in the Size box. 

To change the color, click the arrow next to Color, and either select a color from the eight choices — which 
represent the current color scheme — or click More Colors for additional choices

•	 Click on OK.

3.5 Master Slides

Slide Master

The slide master stores information relating to the underlying formats of the slides in your presentation, including font 
styles, placeholder sizes and positions, background design, and colour schemes and is used to control the appearance of 
the presentation. Each presentation has a Slide Master. When you want to apply consistent formatting through all slides in 
your presentation, you change global attributes by editing the Slide Master. These changes will be automatically reflected 
through each slide (apart from the Title Slide). This is done through the View, Master, Slide Master.
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  Using the Slide Master

Mouse

•	 Select View, Master, Slide Master.

Or

•	 Press [SHIFT]  (Normal View Button).

•	 To establish the formatting for title text, body text, bullets and footers select the relevant sample text or 
bullet and format using the Format menu commands or the Toolbar shortcut buttons.

•	 Place any required graphics, logos and additional headers and footers on the slide master and format as 
desired.

•	 To change the position of any graphic or box of click and drag the object to a new position.
•	 Return to Normal View. (Click on Close Master View button or on Normal View  button).

All your slides will now follow the formatting of the Slide Master. All graphics, logos, headers and footers on the 
master will show on all slides.

If you would prefer the text on any individual slide not to follow the Slide Master format the text of that slide 
individually.

To hide Slide Master items such as graphics/ logos on an individual slide use Format, Background, Omit Background 
Graphics from Master.
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Note: For more information on Slides Masters, creating Multiple Slide Masters and working with Title Masters, 
please see Section 12 (page 139), Slide Masters and Templates.

3.6 The Format Painter

The Format Painter is a tool that you can use to copy all the formats from one area of text to another. This is particularly 
useful when you have spent time formatting one placeholder and you decide that you would like to apply the same 
formatting to another placeholder – rather than reapplying the formats again manually, one by one, you can paint them 
in to the new placeholder or text with the Format Painter.

  To paint formats:

Mouse

•	 Select the placeholder or the text that contains the formatting that you want to use.

•	 Click the Format Painter button from the Standard toolbar . Your mouse pointer will change to display a 
paintbrush next to the selection pointer (white plus).

•	 Select all the cells you want to apply the formats to by dragging over them. As soon as you release the 
mouse, the formats will appear.

The format painter will paint the formats from your chosen area and will then turn off. You can keep the format 
painter turned on to enable the painting of multiple areas by double clicking on the format painter instead of single 
clicking as above. To turn the format painter off when finished, press [Esc] or click once on the Format Painter button.

WALTER LAUTER

IT-Spezialist Serversysteme ZF Friedrichshafen AG

ICH BEI ZF. INFORMATIKER 
UND OUTDOOR-PROFI.
www.ich-bei-zf.com

Scan den Code und 
erfahre mehr über mich 
und die Arbeit bei ZF:
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3.7 Changing Case

If the case of the letters is wrong, rather than deleting and re-typing in the correct case, you can use the following 
formatting option.

  To change text case:

Mouse

•	 Select your text.
•	 Select Format, Change Case.

•	 Choose desired case.
•	 OK.

Once your text is selected you can also use [SHIFT] + [F3] to toggle between Upper, Lower and Sentence case.

3.8 Smart Tags

Smart Tags, first introduced in Microsoft Office XP, make it easier for you to complete some of the most common tasks 
in PowerPoint 2003 and provide you with more control over automatic features. 

You do not have to complete any additional steps to make the Smart Tags appear or disappear in PowerPoint. The Paste 
Options, AutoCorrect Options and AutoFit smart tags appear automatically to allow you to quickly choose actions and 
remain in place until you begin another action. For example, when you complete a paste operation, the Paste Options 
smart tag (below) remains in place alongside your text until you begin typing new text.
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About smart tags

A “smart tag” is a type of button in Microsoft PowerPoint 2003 that appears after certain actions, such as an automatic text 
correction or a copy-and-paste, have taken place. The button has a menu of options that help you control the result of the 
action. For instance, if PowerPoint automatically capitalizes the first letter of a word, but you want the word lowercased 
in this instance, you can click the “undo capitalization” option on the button menu to reverse the action.

PowerPoint includes several of these smart tag buttons. They function similarly but their look can vary and each has a 
specific purpose.

 AutoCorrect Options Smart Tag

The AutoCorrect Options Smart Tag appears after an automatic correction or change, such as a lowercased letter that’s 
changed to a capital or a network path that’s converted to a hyperlink. The Smart Tag shows as a small, blue box when 
you rest the mouse pointer near text that was changed; it then becomes a button icon which, when you point to it and 
click it, displays a menu. If you don’t want the correction, use the options on the menu to undo it; turn off this type of 
correction completely; or connect to the AutoCorrect dialog box to adjust settings.

 Paste Options Smart Tag

The Paste Options Smart Tag gives you greater control and flexibility in choosing the format for a pasted item. The Smart 
Tag appears just below a pasted item, such as text, a table, or a slide, with options for formatting. For example, if you 
copy and paste a slide and insert it after a slide that uses a different design template, you can choose to retain the original 
design for the slide or let the pasted slide assume the design of the slide it now follows.

 AutoFit Options Smart Tag

The AutoFit Options Smart Tag appears when PowerPoint resizes text you’re typing to make it fit the current placeholder. 
If you don’t want the text to be resized, you can select options on the Smart Tag menu to undo the resizing or to connect 
to the AutoCorrect dialog box to turn AutoFit settings off. Also, for single-column layouts, you can change to a two-
column layout, start a new slide to accommodate the text, or split the text between two slides. 

 Automatic Layout Options Smart Tag

The Automatic Layout Options Smart Tag appears after you insert an item, such as a picture, diagram, chart, or table, 
that changes the initial layout of the slide. To accommodate the added item, PowerPoint will automatically adjust the slide 
layout. If you want, use the options to undo the automatic layout or turn it off completely. 
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4 PowerPoint Views
Objectives

The following topics are covered in this chapter:

•	 Normal (Tripane) View 
•	 Slide Sorter View
•	 Outline View
•	 Notes Pages View
•	 View in Black and White
•	 Print Preview

Die Consorsbank ist eine der führenden Direkt-
banken Europas. Lege jetzt als Werkstudent 
oder Praktikant bei uns den Grundstein für 
deine erfolgreiche Karriere.

Einfach online bewerben unter: 
www.consorsbank.de/karriere

DEINE SCHNITTSTELLE ZUM ERFOLG. 
HIER BIST DU RICHTIG VERBUNDEN!
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4.1 Different ways to view slides

When you are creating your presentation you can switch between different views within PowerPoint, each of which allows 
you to work in different ways. The views available in PowerPoint 2003 are:

Normal (Tri Pane) View

Slide Sorter View

Notes Page

Slide Show

To switch between these different presentation views you simply need to select the view from the View menu. 

Alternatively, you can click on the required view button at the bottom left of the screen. 

However, this option only gives you access to Normal. Slide Sorter, and Slide Show views.

The Normal (Tri Pane) View

In the Normal view you can display the slide, outline and notes views in their own adjustable panes, so you can see 
everything at once. Normal view is the main editing view, which you use to write and design your presentation. The view 
has three working areas: on the left, tabs that alternate between an outline of your slide text (Outline tab) and your slides 
displayed as thumbnails (Slides tab); on the right, the Slide Pane, which displays a large view of the current slide; and 
on the bottom, the Notes Pane.
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The Outline Tab

This pane enables you to edit your presentation quickly when it contains a large amount of text. You can add new slides 
and text in Outline View. This area is a great place to start writing your content, planning the logical order you want to 
present your ideas in, and move slides and text around

Slide Sorter View

Slide sorter view is an exclusive view of your slides in thumbnail form.

When you are finished creating and editing your presentation, slide sorter gives you an overall picture of it making it easy 
to reorder, add, or delete slides and preview your transition and animation effects.

  To change the order of your slides:

Mouse

•	 Click on the slide you wish to move and drag it to the position you require.
•	 Repeat this process until your slides are in the correct order.

Slide Show View

Instead of having OHP transparencies produced you can show your presentation directly from your computer, using the 
electronic slide show. You can show the presentation on the computer monitor or use an LCD panel and project the show 
onto an overhead screen.

Slides fill the whole screen and display exactly as formatted. As you click with your mouse or press [ENTER] on your 
keyboard you will automatically be taken through each slide.
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Furthermore you can incorporate a range of extra features such as transitions (the way one slide makes way for the next) 
and animated build effects (which allow objects such as text and graphics to “fly” onto the slide in different ways). You 
can also include movies and sounds in your presentation as well as buttons which allow the user to branch from one slide 
to another. Transitions and Animations will be detailed in later sections.

Note: When choosing the slide show button at the bottom left of your screen, your slide show is started from the 
slide you have selected. However, when starting the slide show from View, Slide Show you will always be started 
from the first slide in the presentation.

View in Black and White 

To see a presentation in Black and White select View, Color/Grayscale and select either Grayscale or Pure Black and White. 

The presentation slides will now display in black and white but note that the thumbnails will still appear in colour. If 
legibility and contrast has deteriorated, select each object, Right Click the mouse and select Black and White from the 
shortcut menu. This will offer alternative shading options listed to the right.

If you want your presentation to print in Black and White, the Color/Grayscale option in the Print dialog box (File, Print) 
will convert your presentation to grey scale as it prints. The Pure Black and White option in the Print dialog box will 
print all colours as black or white only.

Print Preview

PowerPoint 2003 gives you the ability to preview the way your slides will look before they are printed out on paper.

  To use print preview

Mouse

•	 From the File menu, choose Print Preview.
•	 Use the up and down arrow buttons to advance through your slides. 
•	
•	 You can choose other options for what to print e.g. handouts with six slides per page, by choosing a new 

option from the Print What box by clicking on the downward arrow. 
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•	 You can choose other printing options by clicking on the Options button on the menu. e.g. to create a frame 
around each slide choose Frame Slides. The Scale to Fit Paper option will resize your slides for printing on 
A4 paper.

•	 To return to your previous view after working in Print Preview, click on the Close button. 
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5 Working with Outline View
Objectives

The following topics are covered in this chapter

•	 Using Outline View to enter text 
•	 Creating slides in Outline View 
•	 The Outlining Toolbar
•	 Creating a Summary Slide
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5.1 Using Outline View to enter Text

The Outline Tab

This pane enables you to edit your presentation quickly when it contains a large amount of text. You can add new slides 
and text in Outline View. This area is a great place to start writing your content, planning the logical order you want to 
present your ideas in, and move slides and text around. 

Sie sind einzigartig? Wir auch!
einzigartige Lösungen

einzigartiger Auftrag einzigartiger Arbeitgeber

einzigartige  Ideen
einzigartige Vielfalt

Wir suchen

Ingenieure/innen der Elektro- und Informationstechnik
Informatiker/innen

mit den Abschlüssen FH/Bachelor

Mehr Informationen zum Thema Karriere beim BND unter 
www.bundesnachrichtendienst.de (Karriere)
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  To work in Outline View

•	 Click the Outline tab from the Normal (Tri Pane) View

The outline format helps you edit your presentation’s content and move bullet points or slides around. It allows you to 
create new slides and add text to slides very quickly.

  To add new body text:

Keyboard

•	 Position the cursor at the end of the title
•	 Press [CTRL] [ENTER]
•	 Type in first paragraph of body text.
•	 Press [ENTER] for each new line of body text.

Note: When you save your presentation as a Web page, the text on the Outline tab becomes a table of contents so 
that you can navigate through the slides. 

Creating slides in Outline View

It is also possible to create new slides using Outline View.

  Add a new slide

Keyboard

•	 Position the cursor at the end of the previous slide.
•	 Press [CTRL] [ENTER].
•	 Type in the title of the new slide.

Note: Outline View will display all slides with a slide icon to the left . Outline View will not display graphic 
objects.

5.2 The Outlining Toolbar

When in Outline Format an extra toolbar is available, the Outlining Toolbar. 

You can increase or decrease text indents, collapse and expand content so that you see slide titles but no subordinate 
bullet points, and show or hide text formatting as you work.
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  To select text in Outline View. 

•	 To select all text on a slide, on the Outline tab in normal view, point to the slide icon, and when the pointer 
changes to a four-pointed arrow, click the icon.

•	 To select a bulleted item and all its subordinate paragraphs, point to the bullet, and when the pointer 
changes to a four-pointed arrow, click. 

Expand or collapse text

When you work with text on the Outline tab in normal view, you can collapse text so that you see only the first outline 
level (slide titles) as you organize. You can re-expand text at any time. You increase or decrease text indents, collapse and 
expand content so that you see slide titles but no subordinate bullet points, and show or hide text formatting as you work

  To collapse text on one slide

•	 Double-click the slide icon.

OR 

•	 Press [ALT] + [SHIFT] +[MINUS SIGN]. 

  To Collapse all text in the presentation

•	 On the Outlining toolbar, click Expand All. (This toggles between collapsing and expanding text.)

OR

•	 Press [ALT] + [SHIFT] +[1]. 

  To Expand text on one slide

•	 Double-click the slide icon. 
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OR

•	 Press [ALT] + [SHIFT] + [PLUS SIGN]. 

  To Expand all text in the presentation

•	 On the Outlining toolbar, click Expand All. 

OR

•	 Press [ALT] + [SHIFT] +[9]

Decrease or increase text indents in an outline

You can increase or decrease text indents, using the Outline Toolbar. On the Outline tab in normal view, click the text 
whose indent level you want to change. 

  To decrease an indent,

•	  On the Outlining toolbar, click Demote.

OR

•	 Press [SHIFT] + [TAB] 
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  To increase an indent

•	 On the Outlining toolbar, click Promote

OR

•	 Press [TAB].

5.3 Importing text stored in other formats

In some cases, you may prefer to use a Word Processor to create your slide show outline. As long as that document uses a 
format that PowerPoint understands (RFT, TXT, DOC, etc), it can create a slide show outline directly from the document, 
saving you valuable time.

  To Import a pre-existing outline

•	 Click on the New Presentation icon.
•	 Click on the Outline tab.
•	 Choose File, Open and navigate to the directory that contains your outline document by changing the Look 

In field.
•	 Select All Outlines in the Files of Type field.
•	 Double click the file to select it for importing.

5.4 Creating a Summary Slide

To introduce or close a slide show presentation, you can create a slide that includes the titles of all your slides or certain 
selected slides in your presentation. This is sometimes referred to as the title slide, which is a new slide, with bulleted 
titles from the selected slides, appearing in front of the first selected slide. 

The Summary Slide can be created in either Slide Sorter View or Outline View

  To create a Summary Slide in Slide Sorter View

•	 Select the slides whose titles you want to use. 
•	 To select multiple slides, hold down [CTRL] and click the slides you want. 
•	 On the Slide Sorter toolbar, click the Summary Slide icon on the Slide Sorter toolbar  

  To create a Summary Slide in Outline View

•	 Select the slides whose titles you want to use. 
•	 To select multiple slides, hold down CTRL and click the slides you want. 
•	 On the Outline toolbar, click Summary Slide icon on the Slide Sorter toolbar  
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6 Working with Slide Sorter View
Objectives

By the end of this section you will be familiar with:

•	 Using Slide Sorter View
•	 Deleting Slides 
•	 Moving and copying slides within the same presentation 
•	 Moving and copying slides between different presentations
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6.1 Using Slide Sorter view

When you are finished creating and editing your presentation, slide sorter gives you an overall picture of it - making it 
easy to reorder, add, or delete slides and preview your transition and animation effects.

  To change to Slide Sorter View

Mouse

•	 Choose View, Slide Sorter

Or

•	 Click on the Slide Sorter button at the bottom left of the screen

  Deleting a slide

Mouse

•	 Switch to Slide Sorter View
•	 Select the slides you want to delete. (If you want to select slides in order, press [SHIFT] as you click; for 

slides not in order, press [CTRL] as you click.) 
•	 On the Edit menu, click Delete Slide. 

Keyboard

•	 You can also press DELETE to delete slides

Moving & Copying slides within the same presentation

  To Copy slides within a presentation

•	 Select the slides you want to copy. Click to select a single slide, press [SHIFT] while clicking to select slides 
in a row, or press [CTRL] while clicking to select slides not in a row.

•	 Then choose Copy.
•	 Click the slide you want your copied slides to follow, and choose Paste. 

If the slides you pasted use a different design template than the slide you pasted after, and you want to keep the 
original formatting, go to the next step. Otherwise, the pasted slides assume the formatting of the slide they follow, 
and the paste is complete. 
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•	 To retain the slides’ original formatting, click the Paste Options smart tag , which appears under the 
slides you pasted, and on the button menu, click Keep Source Formatting. 

•	 If you decide you want the current design template styles to apply, click Use Design template formatting 
(this is the default). 

  To Move slides within a presentation

•	 Select the slides you want to copy. Click to select a single slide, press [SHIFT] while clicking to select slides 
in a row, or press [CTRL] while clicking to select slides not in a row.

•	 Then choose Cut.
•	 Click the slide you want your copied slides to follow, and choose Paste. 

If the slides you pasted use a different design template than the slide you pasted after, and you want to keep the 
original formatting, go to the next step. Otherwise, the pasted slides assume the formatting of the slide they follow, 
and the paste is complete. 

•	 To retain the slides’ original formatting, click the Paste Options button , which appears under the slides 
you pasted, and on the button menu, click Keep Source Formatting. 

•	 If you decide you want the current design template styles to apply, click Use Design template formatting 
(this is the default). 

Note: To drag the slides, select them, drag them to the new position on the Slides tab, look for the horizontal line 
under the slide where you want to paste, then release 

Note: To copy, you can also press CTRL+C; to cut, you can press CTRL+X; to paste, you can press CTRL+V.

6.2 Moving and Copying Between Presentations

Moving and copying slides between presentations allows you to easily access slides contained in different presentations 
and include them in your current presentation.

  To copy slides between presentations

•	 Ensure that both the PowerPoint files are open i.e. both the source of the PowerPoint slides being copied and 
the destination file that the slides are being copied into.

•	 On the Window menu, click Arrange All. 
•	 Select the slides you want to copy (within the source file). Click to select a single slide, press SHIFT while 

clicking to select slides in a row, or press CTRL while clicking to select slides not in a row.
•	 Then choose Copy.
•	 Click into the slide you want your copied slides to follow (within the destination file), and choose Paste. 

If the slides you pasted use a different design template than the slide you pasted after, and you want to keep the 
original formatting, go to the next step. Otherwise, the pasted slides assume the formatting of the slide they follow, 
and the paste is complete. 
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•	 To retain the slides’ original formatting, click the Paste Options button , which appears under the slides 
you pasted, and on the button menu, click Keep Source Formatting. 

•	 If you decide you want the current design template styles to apply, click Use Design template formatting 
(this is the default). 

  To move slides between presentations

•	 Ensure that both the PowerPoint files are open ie. both the source of the PowerPoint slides being copied and 
the destination file that the slides are being copied into.

•	 On the Window menu, click Arrange All. 
•	 Select the slides you want to copy (within the source file). Click to select a single slide, press SHIFT while 

clicking to select slides in a row, or press CTRL while clicking to select slides not in a row.
•	 Then choose Cut.
•	 Click into the slide you want your copied slides to follow (within the destination file), and choose Paste. 

If the slides you pasted use a different design template than the slide you pasted after, and you want to keep the 
original formatting, go to the next step. Otherwise, the pasted slides assume the formatting of the slide they follow, 
and the paste is complete. 

•	 To retain the slides’ original formatting, click the Paste Options button , which appears under the slides 
you pasted, and on the button menu, click Keep Source Formatting. 

•	 If you decide you want the current design template styles to apply, click Use Design template formatting 
(this is the default). 
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7 Drawing Skills
Objectives

By the end of this section you will be familiar with:

•	 The Drawing Toolbar
•	 Drawing and resizing basic shapes freehand
•	 Formatting Shapes
•	 Copying and Moving
•	 Working with Guides
•	 Working with the Visible Grid
•	 Aligning and distributing Objects
•	 Flipping and Rotating
•	 Ordering and Grouping Objects
•	 Inserting and formatting text within a shape
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7.1 Drawing

PowerPoint offers a wide range of drawing tools which allow you to create your own pictures to visually enhance your 
presentation. You also have a comprehensive Clip Art gallery of pictures which can be inserted into your slides.

The Drawing Toolbar
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IT-Projektmanagerin bei der KfW hat sie in einem interdisziplinären Team erreicht, dass Bauherren schon während des 
Beratungsgesprächs erfahren, ob die Wäremdämmung ihres Eigenheims gefördert werden kann. Damit leistet sie täglich einen 
innovativen Beitrag für mehr Kundennähe und den Klimaschutz. Und wann fangen Sie an?

Jetzt informieren auf www.kfw.de/karriere
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Drawing Basic shapes freehand

  To draw freehand shapes

•	 On the Drawing toolbar, click AutoShapes, and then point to Lines. 
•	 You can click on the Freeform  button to draw an object with both curved and straight segments. Drag 

to draw freehand shapes; click and move the mouse to draw straight lines.  
To end a shape and leave it open, double-click at any time. To close a shape, click near its starting point. 

•	 The Scribble  button can be used to and drag out a shape that looks more like it was drawn with a pen 
or to create smooth curves

Creating Regular Shapes

There are four basic shapes, each with its own button:

To draw a shape, click on the shape to select it, then click on the top left corner where you want to start and drag the 
outline of the shape downwards. Release the mouse and the shape appears on the slide.

If you hold down the [SHIFT] key while dragging an oval or a rectangle, PowerPoint keeps the object the same width 
and height. That way you can make perfect circles and squares. Release the mouse before you release the [SHIFT] key.

Holding down the [SHIFT] key while dragging a line or arrow keeps your line at an angel that’s an exact multiple of 15 
degree increments, which is particularly useful for making exactly horizontal or vertical lines. Release the mouse before 
you release the [SHIFT] key.

Drawing perfect squares, circles and straight lines

You can ensure that your shapes are perfectly square or round or that your lines are horizontal, vertical or 45° angles by 
using the [SHIFT] key as you draw them.
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  To draw “perfect” objects:

Mouse

•	 Select a Shape Tool.
•	 Hold [SHIFT] as you click and drag to define the shape on the slide.
•	 Release the mouse before you release the [SHIFT] key.

Drawing objects from centre outwards

Sometimes, it’s useful to draw a shape by anchoring its centre point and then dragging. This is particularly useful when 
trying to position things accurately on a slide.

  To draw an object from the centre out:

Mouse

•	 Select a Shape Tool.
•	 Hold [CTRL] as you click and drag to define the shape on the slide.
•	 Release the mouse before you release the [CTRL] key.

Note: you can draw a perfectly regular shape from the centre outwards by holding down [SHIFT] + [CTRL] as 
you draw the shape.

7.2 Selecting Objects

Any shape or line that you draw is called an Object and must be selected before you can move, resize or format it. Selected 
objects display eight resizing handles around them.

  To select one object:

Mouse

•	 Click on the object.
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  To select several objects:

Mouse

•	 Click on the first object.
•	 Press the [CTRL] key. Click on each other object in turn.

Or

•	 Click and drag a rectangle around the objects. All objects within the area will be selected.

Or

•	 Press [CTRL] [A] to select all objects on the slide (including text objects).

7.3 Formatting objects using the menu

PowerPoint’s Format menu gives you plenty of scope for changing an object’s attributes which will change it’s appearance 
on the slide. 
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  To format an object using the menu:

Mouse

•	 Select the Object to be formatted.
•	 Select Format, Colours and Lines.

Or

•	 Select Format, AutoShape.

The Colours and Lines tab

Fill

The fill is the colour of the shape. Choose from solid or semitransparent fill, gradient, textured, pattern and picture fills, 
background colour or none.

Semitransparent Fill allows objects behind to show through:

(For information on gradient, textured, pattern and picture see section on Applying Slide Background, page 147).
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Lines

Use the options in the Colours and Lines tab to format the colour, style and weight of the line and to set a dashed effect 
if desired. Connectors can be changed between straight, elbowed and curved types.

Arrows

Lines can be formatted with arrow heads and tails. The beginning of a line is the end at which the line was started when 
drawn. 

The Default for new Objects options allows you to specify current settings as the default for all new objects drawn 
from that point forward.

The Size tab

This dialog box tab offers a variety of methods to resize your object. You can resize using exact measurements or using 
percentage scaling. 

The Lock aspect ratio option allows you to easily resize your object without losing the original proportions.
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The Position tab

The settings in this dialog box tab allow you to position an object relative to the edges or the centre of the page.

http://bookboon.com/
http://bookboon.com/count/advert/87dbf028-e113-43e3-841b-a39300a7f09d


Download free eBooks at bookboon.com

PowerPoint 2003: Part I

75 

Drawing Skills

Text Box Tab

The settings in this dialog box allow anchoring the text in a textbox in various formats. The ability to adjust the size of 
the autoshape so the text fits inside it was added in PowerPoint 2000.

Note: The Text Box tab will not be available until you have entered text onto your object. To type text onto an 
object, select the object and begin to type.

Web Tab 

Type the text you want to be displayed while pictures are loading on your web page.
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7.4 Formatting objects using the toolbar

There are also a number of buttons on the Drawing Toolbar which can be used to format objects.

The Shadow button gives access to a range of shadow options for your object. To customise these further select the Shadow 
Settings command.This opens the Shadow Settings toolbar which allows you to nudge the shadow in any direction, change 
the colour of the shadow and set the shadow to be semitransparent.
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The 3-D button gives access to a range of 3-D effects for your object allowing you to transform a flat object into a solid 
one. To customise the settings select the 3-D Settings command. This opens the 3-D Settings toolbar which allows you to 
tilt the object, change the depth and direction, the lighting effect, the surface texture and the colour.
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7.5 Resizing Objects

If you need to enlarge or shrink an object, you can use the sizing handles that appear when it is selected.

  To resize an object:

Mouse

•	 Select the object (when an object is selected 8 resizing handles should appear).
•	 Click and drag a resizing handle to resize the object.

Or

•	 Click and drag an adjustment handle to re-proportion the object.

Text boxes are also objects and have similar resizing handles to graphic objects and can be resized in the same way.

7.6 Moving Objects

If you need to reposition an object on a slide you can very easily move it.

  To move an object:

Mouse

•	 Select the object.
•	 Click and drag to move. (Click on centre of object or on fuzzy border). As objects are being moved an 

outline of the object shape will be displayed to help you position them accurately.
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Keyboard

•	 Select the Object.
•	 Use the arrow keys to move it in a particular direction
•	 OR
•	 Press [CTRL] [X] to cut the object out.
•	 Press [CTRL] [V] to paste a duplicate back onto the slide.

Note: Holding down the [SHIFT] key and moving an object will move the object and keep it in a parallel line 
with its original position

7.7 Copying Objects

If you need to ensure that you have an exact duplicate of an object you have drawn, the best technique is to copy it. There 
are several ways you can do this described below.

  To copy an object:

Mouse

•	 Select the object.
•	 Press the [CTRL] key.
•	 Click and drag to move and copy (click on centre of object or on fuzzy border).

Keyboard

•	 Select the Object.
•	 Press [CTRL] [C] to cut the object out.
•	 Press [CTRL] [V] to paste a duplicate back onto the slide.

Note: Holding down the [SHIFT] + [CTRL] keys and dragging an object will copy an object and keep it parallel 
to the original

7.8 Working with Guides

Guides are vertical and horizontal lines used to visually align objects. When an object is close to a guide line the edge or 
centre of the object will snap to the guide.
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  To display and hide guides:

Mouse

•	 Choose View from the menu bar, then click Grid and Guides.

Or

•	 Press [CTRL] [G].
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•	 Select Display drawing guides on screen
•	 Choose OK

  To move the guides:

Mouse

•	 Click on the guide line.
•	 Drag the guide to the required position. 

As you drag the guide a measurement will appear. This is the distance of the guide from the centre of the page.

  To create additional guides:

Mouse

•	 Click on an existing guide line.
•	 Hold the [CTRL] key.
•	 Drag to the required position.

As you drag the guide a measurement will appear. This is the distance of the guide from the centre of the page.

  To delete guides:

Mouse

•	 Click on the guide line and drag it off the slide.

7.9 Working with the Visible Grid

The grid is a set of intersecting lines used to align objects. It can make it easier for you to align objects, because they give 
you a visual cue in relation to the objects and the slide. 

Use the grid to help align objects more precisely, particularly in relation to each other.
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The grid can be shown or hidden. Grids are not visible in a slide show and they do not print.

  To show and hide the grid

Mouse

•	 Choose View from the menu bar, then click Grid and Guides.

Or

•	 Press [CTRL] [G].
•	 Select Display grid on screen
•	 Change the grid settings to increase or decrease the distance between the grid lines
•	 Choose OK.

Snap to Grid

The grid includes an option called snap-to, which aligns objects to the nearest intersection of the grid or to another object 
as you draw or move objects. The snap-to option is turned on by default and works even when the grid is not visible. In 
most cases, having objects snap-to assists you in laying out your slide accurately. However, occasionally, you may find the 
grid snap-to option prevents you moving objects freely and placing them exactly where you want. In these cases, turn 
off the grid snap.

  Turning off grid snap

•	 Choose View, Grid and Guides
•	 Untick the Snap objects to grid option. This will turn off grid snap for all objects until you choose to turn it 

back on.

OR
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•	 Hold down [ALT] as you are moving an object. This will temporarily turn off grid snap.

7.10 Aligning and Distributing Objects

After you have created several objects you may wish to align them in relation to each other and to distribute them evenly. 
For example you can align three rectangles so that their top edges are all at the same height and the gap between each 
one is equal.

  To align or distribute objects:

Mouse

•	 elect the Objects to be aligned.
•	 Select Draw, Align or Distribute. Select the option required using the illustrations for each command as a 

guide.
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7.11 Rotating/ Flipping Objects

If you need a mirror image of an object you can flip it over in any direction.

  To rotate or flip an object:

Mouse

•	 Select the object.
•	 Click on Draw, Rotate/Flip.
•	 Choose the appropriate option from the cascading menu. Use the pictures to help you select the option you 

need.
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The Rotation Handle

In PowerPoint 2003 you have the ability to free rotate all objects easily using the rotation handle.

  Using the rotation handle

•	 Hover your mouse over the rotation handle until your mouse pointer changes to a circular arrow symbol.
•	 Click and drag with the mouse to move the object around to the desired new position.

The rotation handle can be found on most objects in PowerPoint 2003 e.g. images inserted from file, text boxes, 
clipart and AutoShapes. 

7.12 Ordering (Stacking) objects

PowerPoint stacks objects automatically as you add them to a slide, giving every object its own layer. You see the stacking 
order when objects overlap: the top object covers a portion of the objects underneath it. This is exactly like putting down 
several pieces of paper on a desk. The top (front) piece will obscure the piece underneath it.

You can move individual objects or groups of objects within a stack. For example, you can move objects forwards or 
backwards through the stack one level at a time or you can bring an object to the front of the stack or send it to the back 
of the stack in one move. 
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  To change stacking order:

Mouse

•	 Click on the object to be moved.
•	 Select Draw, Order.
•	 Select the option required.

7.13 Grouping Objects

Grouping objects combines them so you can work with them as though they were a single object. You can flip, rotate, and 
resize all the objects in the group as a single unit. You can also change the formatting of all objects in a group at one time. 
Grouping is particularly recommended if you individual objects that as a whole make up a diagram or flow chart. To 
prevent one object accidentally coming out of alignment with the rest, when you have finished working on the diagram 
objects, group the objects together for safety. It is always possible to ungroup later to make amendment to individual objects. 
PowerPoint 2003 also lets you change certain attributes of individual objects even though they may be part of a group. 

  To group objects:

Mouse

•	 Select all the objects.
•	 Select Draw, Group.

To work on the objects individually again, ungroup them using the Draw, Ungroup command.
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7.14 Inserting text within an object

All the objects that you can draw onto a slide that have an interior have a text anchor point, which means that you can 
type text inside them. If the object is moved, the text will move with it.

  To add text to an object:

Mouse

•	 Select the object.
•	 Type text straight in. (Do not select the Text Box button). 
•	 The text is part of the object itself; when the object is moved the text will move with it.

The text does not automatically wrap to the next line. Press the [ENTER] key for a new line or check the Word-
wrap option in Format, AutoShape, Text Box (see below).

Formatting Object Text 

  Text Box formatting

•	 Select the Shape or Text Box object.
•	 Select Format, AutoShape from the menu bar OR right click your shape and select Format AutoShape.
•	 Click on the Text Box tab. Choose from the following options:

Change Text Anchor Point to reposition text within shape or text box.
Change Internal Margins to increase or decrease the distance between the text and the edge of the object.
Switch on Word wrap text in AutoShape to force the text to wrap to the next line automatically. )This option 
is switched on by default for Text Boxes).
Switch on Resize AutoShape to fit text to force PowerPoint to adjust the size of the shape to accommodate the 
text. (This option is switched on by default for Text Boxes).
Use Rotate text within AutoShape by 90° to turn the text a quarter turn to the right.

•	 Click on OK.
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  To alter font formatting in an object:

Mouse

•	 Select the Text.
•	 Click on Format, Font.

•	 Set the options for Font, Size, Colour and Style. Choose from Effects such as Shadow, Emboss and 
Underline.

•	 Click on OK.

You can also use the shortcut buttons on the Formatting Toolbar.
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8 Working with Clip Art
Objectives

By the end of this section you will be familiar with:

•	 Inserting Clip Art 
•	 Moving and Resizing
•	 Recolouring Clip Art
•	 Grouping and Ungrouping Clip Art
•	 Cropping Clip Art
•	 Using Image Settings
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Read more about this and our other international masters degree programmes at www.uu.se/master
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8.1 Inserting Clip Art

Because we are not all equally talented in the drawing stakes and because drawing anything with a mouse is extremely 
difficult, Microsoft supply a huge gallery of pictures ready and waiting to be picked and used. These pictures are referred 
to as Clip Art. Inserting a piece of Clip Art onto a slide is very easy.

  To insert a Clip Art picture:

Mouse

•	 Select Insert, Picture, Clip Art
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Or

•	 Click on Insert Clip Art  button.
•	 Type a word or text string that describes the clip you are looking for or type in all or some of the file name 

of the clip. 
•	 To narrow your search, do one or both of the following: 

- To limit search results to a specific collection of clips, in the Search in box, click the arrow and select the 
collections you want to search. 
- To limit search results to a specific type of media file, in the Results should be box, click the arrow and select 
the check box next to the types of clips you want to find. 

•	 Click Search. 
•	 Click on Clip Art piece to insert
•	 For further options, click on the drop down arrow

http://bookboon.com/


Download free eBooks at bookboon.com

PowerPoint 2003: Part I

93 

Working with Clip Art 

•	 If you cannot find a clip that you want click on Clip art on Office Online to browse Microsoft’s online clip 
art library

8.2 Resizing and Moving Objects

Resizing Objects

If you need to enlarge or reduce the size of a piece of Clip Art, you can use the sizing handles that appear when it is selected.

  To resize Clip Art:

Mouse
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•	 Select the Clip Art. (8 resizing handles should appear).
•	 Click and drag a resizing handle to resize the object. 

Or

Click and drag an adjustment handle (corner) to re-proportion the object.

8.3 Moving Clip Art

If you need to reposition an object on a slide you can very easily move it.

  To move an object:

Mouse

•	 Select the piece of Clip Art.
•	 Click and drag to move. (Click on centre of piece of Clip Art or on fuzzy border). As Clip Art is being 

moved an outline of the shape will be displayed to help you position it accurately.

8.4 Re-Colouring Clip Art

Clip Art pictures comprise a variety of grouped objects each with their own interior colour. Occasionally, you may find a 
picture that exactly suits your needs but one or more of the colours is wrong. You can alter the individual colours using 
the method described below. The Picture toolbar is used when recolouring Clip Art. 

The Picture Toolbar

  To re-colour a Clip Art picture:

Mouse

•	 Select Clip Art picture.
•	 Click on Format, Picture, Select the Picture tab and click on Recolor.
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Or

•	 Click on Recolour  button on Picture toolbar.

•	 Find the colour you would like to change in the Original column.
•	 In the New column choose a replacement colour.
•	 Click on OK.
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Look up for our continuous offers of graduate 
positions at our various locations within Ger-
many (Backnang, Duesseldorf, Frankfurt, Her-
zogenrath/Aachen). We are looking forward 
to getting to know you! Apply via the internet: 
www.ericsson.com/careers 

http://bookboon.com/
http://bookboon.com/count/advert/0ef616e5-3070-49f0-9be6-a1a200983584


Download free eBooks at bookboon.com

PowerPoint 2003: Part I

96 

Working with Clip Art 

8.5 Ungrouping Clip Art

If you need to adjust more than colour in a Clip Art picture you can ungroup it. Ungrouping will convert it to a PowerPoint 
drawing allowing you to manipulate the objects which make up the picture using the PowerPoint drawing tools and 
commands. When finished, the picture can be regrouped, however it will then treated as a PowerPoint drawing rather 
than a Clip Art and options such as Recolour will not be available.

  To ungroup Clip Art:

Mouse

•	 Click on the Clip Art picture.
•	 From the Drawing toolbar at the bottom left of the screen, select Draw, Ungroup.

It may be necessary to ungroup a Clip Art more than once. For example, a Clip Art of a person when first ungrouped 
may allow you to separate the head, body and limbs. The head may need to be ungrouped again to allow you to 
separate the facial features.

  Regrouping the picture:

Mouse

•	 Select all objects in picture.
•	 Select Draw, Regroup.

The original Clip Art on the left was ungrouped. The scrolled parchment was flipped, the rosette moved and text added 
before the picture was regrouped.

8.6 Cropping Clip Art

Both Clip Art images and your own drawings can be cropped.
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  To Crop using the dialog box:

Mouse

•	 Select picture.
•	 Click on Format, Picture.
•	 Click on the Picture tab.
•	 Enter measurements to crop picture from preferred edge.
•	 Click on OK.

  To Crop using the Picture toolbar:

Mouse

•	 Select picture.

•	 Click on Crop  tool.
•	 Position mouse over one of the resizing handles.
•	 Click and drag to crop.

Pictures can be uncropped again at any time using the techniques above.

8.7 Using Image Settings

You can control image colour, contrast and brightness by selecting the picture and applying the options on the Picture 
toolbar. 

Image Control allows you to convert a picture to Greyscale or Black and White.
Set Transparent Colour allows you to integrate a picture with your slide background. This option is available for bitmap 
pictures that don’t already have transparency information. It’s also available for some, but not all, clip art. You can make 
only one colour transparent. When printed, transparent areas will be the same colour as the paper they’re printed on.. 
In an electronic display, such as a PowerPoint presentation, transparent areas will be the same colour as the background.
Compress Picture enables you to save file space by reducing the resolution of pictures in your presentation (to 96 dots 
per inch (dpi) for Web and 200 dpi for print). Any areas that you have cropped from your picture will also be discarded.
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